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Using MARConnect

MARConnect is an Internet cataloging program. With MARConnect and a browser, you
can search and catalog Internet web sites, which become additional patron resources
when added to your catalog database.

You search the Internet for informational and educational web sites. When you find a site
you want to catalog, click the MARConnect button. MARConnect takes the URL and
title of the site and creates the MARC record for you. You can then add other descriptive
information about the site. After you save your information, MARConnect generates a
MARC record for you. The records are stored in a MARC file that can be imported into
your catalog database. You can also copy and paste MARConnect records directly into
Spectrum CIRC/CAT using your computer’s clipboard.

After the records are imported or pasted into your catalog database, your patrons can
access them while searching the online catalog. These sites will appear as additional
patron resources in future catalog searches and can be accessed with Spectrum
WebConnect, a program that links patrons to electronic resources cataloged in the MARC
856_u tag.

MARConnect is installed automatically with the Windows version of Spectrum
CIRC/CAT client and single-user. Note: MARConnect is not available for Macintosh.

To start the MARConnect program
If you’re using the client/server version of Spectrum CIRC/CAT,
from the Start menu, choose Programs > Winnebago Spectrum
Client > MARConnect.

If you’re using the single-user version of Spectrum CIRC/CAT,
from the Start menu, choose Programs > Winnebago Spectrum
Single User > MARConnect.

The MARConnect window opens. Your default browser also opens
and displays a list of helpful Internet links.

For information on the elements of the MARConnect program, see "Understanding the
program elements in MARConnect" in the MARConnect chapter in the Spectrum
CIRC/CAT Reference Manual.
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Setting MARConnect options

Before you use MARConnect to catalog web sites, you need to set your options. If you
don’t set your options, MARConnect uses the default settings to configure your MARC
records. You can accept the default options as your settings, but Sagebrush recommends
that you set specific options for your library before you use MARConnect to catalog web
sites.

How to set MARConnect options
Example scenario: You want your MARConnect records to have unique material type
numbers so that you can exclude them from the inventory process. You also want to
switch your call numbers to Library of Congress (LC).

1 In the toolbar, click the Options button. The Options window
opens

2 In the Material type text box, enter a value unique from your
other material types.

3 Next to the Call number option, select LC.

4 Click OK.

For more information on the Options window, see "About the Options window".

Set Options
button
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Cataloging a site

When you catalog a site, MARConnect takes the URL and title of the site currently
displayed in your browser and automatically catalogs them as well as other automatically
cataloged fields (for more information, see "About automatically cataloged fields"). You
can then add other information to be cataloged. A record of the site is created and saved
in a MARC file.

About the cataloging process

When you catalog a web site using MARConnect, you perform the following steps:

1 Start the MARConnect program.

2 Make sure that the file to which you want to add the record is active. If
you want to save MARC records to a new MARC file, move your
current file to a backup folder. If you want to append MARC records
to the active MARC file, you can go on to the next step.

3 Using your browser, locate the site you want to catalog.

4 Click the MARConnect button. The site’s title and URL are captured
and placed in the correct fields in the MARConnect window for you.

5 Enter additional site data into the correct fields, as necessary.

6 Save the record.

After you save the MARC record, you can catalog other sites. When you finish
cataloging sites, you may import the MARC records into your database. After you import
the records, move the MARC file to a MARConnect backup folder.

Viewing a site and capturing its title and URL
Before you catalog a web site, you need to view it using your browser. To view a web
site, make sure your computer has Internet access and a Web browser, such as Microsoft
Internet Explorer or Netscape Navigator. For information about the software
requirements, see "Program requirements" in the Spectrum CIRC/CAT Installations
Guide.

When you start the MARConnect program, your browser is launched. Using your
browser, you search the Internet for information and educational sites. When you find a
web site you want to add to your library’s resources, you’re ready to start cataloging the
site’s information. Viewing the site you want to catalog also lets you refer to it when
entering your additional catalog information.
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For more on viewing web sites, see the documentation or Help that came with your
browser software.

How to view a site and capture its URL and title
Example scenario: You found a web site titled Abraham Lincoln. Its URL is
http://www.geocities.com/SunsetStrip/Venue/5217/lincoln.html. You decide you want
your patrons to be able to access this site while searching the online catalog.

Before you begin cataloging a web site, you should make sure that the MARC file you
want to add the MARC record to is active.

To view a site and capture its URL and title
1 In MARConnect, choose Open from the File menu, locate the MARC

file you want to add the MARC record to, and click Open. Note: This
is not necessary if you always use the default MARC file, Marc_001.

2 Using your browser, locate and display the site you want to catalog.
You can type the URL
http://www.geocities.com/SunsetStrip/Venue/5217/lincoln.html into
the Address or Location box of your browser.

3 Click the MARConnect button. The MARConnect window opens and
the site’s URL and title, Abraham Lincoln: An Educational Site, are
placed in the correct fields for you. The title is the text displayed in
the title bar of the browser window.

In addition, MARConnect automatically catalogs other MARC tags
for you.

Now you can enter the rest of the site's information.

You can also capture web site information from the MARConnect program without using
the MARConnect button. In the toolbar of the MARConnect window, click the "Update
URL and Title" button. The URL and title from the web site displayed in your browser
are automatically placed in the MARConnect window. This button may also be useful if
you accidentally change or delete the URL or title in the MARConnect program.
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Entering site information
After you find a site you want to catalog and click the MARConnect button, you can
enter additional bibliographic data that your library may require. This information is
cataloged along with the automatically cataloged fields when you save your record. Note:
You can use shortcut key combinations to navigate through the MARConnect window
when you enter your site data.

Some fields in the MARConnect window don’t apply to all web sites. In these cases, you
can leave the field blank.

Entering author information
MARConnect reserves the first Author–personal or Author–corporate for main entries.
Because of MARC standards, you can only enter one main entry for author, either
personal or corporate but not both. As soon as you type an author in either the Author-
personal box or Author- corporate box, the other box is unavailable. Additional boxes can
be added for additional authors.

How to enter author information
Example scenario: You want to enter two authors for the Abraham Lincoln site that you
are cataloging, Michael Donovan and Pat Nielsen. Both authors are personal authors
rather than corporate.

To add author information
1 In the Author – personal box, enter Donovan, Michael. The

Author – corporate box becomes unavailable.

Note: Because the MARC standard only allows one main entry,
MARConnect does not let you enter a value into both the first
Author – personal and the first Author – Corporate boxes. As
soon as you type something in one of the main author boxes,
the other box becomes unavailable.

2 Click the Add Author button located to the right of the Author
– personal box. This creates another Author – personal box.

3 In the second Author – personal box, enter Nielsen, Pat.
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Entering title information
MARConnect automatically enters the title of the site for you when the MARConnect
button is activated. However, you can change the title. You can also enter a subtitle
and/or an alternate title for the site. The title is stored in tag 245_a, subtitle in 245_b, and
alternate in 246_a of a MARC record.

How to change a title and add a subtitle and/or alternate title
Example scenario: For the Abraham Lincoln web site that you are cataloging, you want
to change the title from Abraham Lincoln: An Educational Site to President Abraham
Lincoln: An Educational Site. Then you’re going to add a subtitle, Biography of a
President.

To change the title and add a subtitle and/or alternate title
1 In the Title box, edit the title that was automatically entered,

Abraham Lincoln: An Educational Site to read President Abraham
Lincoln: An Educational Site.

2 In the Subtitle box, enter Biography of a President.

Entering publication information
The following publication information can be cataloged and saved to a MARC record:
publisher, place of publication, and date of publication. Some web sites may not supply
all of the publication information. These areas can be left blank. Some sites list a host
name but not a publisher name. In this case, you could substitute the publisher’s name
with the host name.

The place of publication is stored in tag 260_a, publisher’s name in 260_b, and the date
of publication in 260_c of a MARC record.

How to enter publication information
Example scenario: The Abraham Lincoln web site that you are cataloging is hosted on
GeoCities and was created in 1997.

To enter publication information
1 In the Publisher box, enter the host name, GeoCities.

2 Press the Tab key on your keyboard twice.
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3 In the Date of publication box, enter 1997.

Entering notes information
In the Notes group, you have the option of rating the quality of a site and entering
information for a general note, summary, public note, and target audience fields.

How to enter notes information
Example scenario: You want to enter some notes for the Abraham Lincoln web site that
you are cataloging.

To enter notes information
1 Next to The quality of this page or site, select a rating for the

quality of the site. For the Abraham Lincoln site, select 4.

2 In the General note box, enter the following general note
information for this site: This site is hosted by GeoCities.

3 In the Summary box, enter the following summary information
for this site: Contains general research information about
Abraham Lincoln, including his childhood, his family members, his
life as president, and his famous speeches.

4 In the Public note box, enter the following public note
information: For more information on Abraham Lincoln or related
topics, see the library’s Reference staff.

5 Select an audience characteristic and an audience type from the
appropriate drop-down box. From the first box, choose
Audience. From the second box, choose General.
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Entering call number information
You have the option of entering either Library of Congress (LC) or Dewey call number
information. You select the type of call number information to be cataloged when setting
your MARConnect options. For more on setting your options, see "Setting MARConnect
options". If you choose LC call numbers, this information is stored in tag 050_a of a
MARC record. Dewey call numbers are stored in tag 082_a.

You can also enter local call number information. This number is stored in tag 090_a of a
MARC record.

How to enter call number information
Example scenario: For an Abraham Lincoln web site you are cataloging, the Dewey call
number is 921. You enter that information in the Dewey call number box. Remember,
you can either enter Dewey call number or an LC call number. You choose the call
number to use in the Options window.

Libraries use the Local call number box in different ways. Some enter WWW so that they
know that this is a web site rather than a book or other physical material in their library.
Some enter local information that indicates where the web site would be shelved if it
were a physical material. For this example, enter WWW.

To enter call number information
1 In the Dewey call number box, enter 921.

2 In the Local call number box, enter WWW.

Entering subject information
You can enter a first subject with up to three subdivisions in the Subject group. Up to five
additional subject boxes can be added as needed. All subjects and subdivisions can have
different classifications based on the options displayed in the list next to each text box.

Your first subject and subdivision combination are stored in one of the following tag
fields in the MARC record, depending on the list selection: tag 600, tag 610, tag 650, tag
651, and tag 690. Each subsequent subject and subdivision combination that you enter
can be stored in any of those tags. The subfield values for these tags are variable. The tag
and subfield combinations are repeatable.
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How to enter subject information
For the Abraham Lincoln web site that you are cataloging, you want to add two subjects.
The first subject is Abraham Lincoln, with a subdivision called Childhood and youth. The
second subject is Presidents, with two subdivisions, Biography and United States.

To enter subject information
1 In the First subject box, enter Abraham Lincoln, and select

Personal Name from the list next to it.

2 In the first Subdivision box, enter Childhood and youth, and
select General from the list next to it.

3 Click the Add Subject button. Another set of subjects and
subdivisions is displayed.

4 In the Second subject box, enter Presidents, and select Topical
from the list next to it.

5 In the first Subdivision box under Second subject, enter
Biography, and select General from the list next to it.

6 In the second Subdivision box under Second subject, enter
United States, and select Geographical from the list next to it.

7 Repeat steps 3 – 6 for each additional subject added.

8 If you are done entering all information for the web site, click
the Save button. The record saves and closes, and a new, blank
record opens so that you can catalog another web site.

Important! Before you save a record, make sure you have
completely and accurately entered all of the cataloging
information. After you save a MARC record, you cannot edit it
again in MARConnect.

Checking the spelling of MARC records
After you capture a web site’s URL and title and enter additional information about the
site, you can check the spelling of the record. It is a good habit to check every record
before you save it. The program checks the spelling of the title, note, and subject fields.
The spell checker program works similar to a spell checking program typically provided
with common word processing programs.
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How to check the spelling of a MARC record
After you finish cataloging a web site, you should check the spelling.

To check the spelling of a MARC record
1 After you have entered all of the catalog information, click the

Check Spelling button. The Check Spelling window opens and
displays the first word that is not listed in the dictionary.

2 Click Ignore or Ignore All to skip the word. Click Change or
Change All to accept the suggested correction. Click Add to
add the word to the dictionary. Click Cancel to close the Check
Spelling window.

Saving a MARC record
After you have finished cataloging a web site, you should save it. MARConnect saves the
information as a MARC record and appends it to the active MARC file.

MARConnect lets you work with multiple MARC files, saving different records to
different files. However, in most cases, you can continue to save all of your MARC
records to the default MARC file (Marc_001).

To save a MARC record
Important! Before you save a record, make sure you have
completely and accurately entered all of the cataloging
information. After you save a MARC record, you cannot edit it
again in MARConnect. (However, you can still edit the record in
Spectrum CIRC/CAT after you import it.)

After you have entered all of the catalog information, click the
Save button in the toolbar. A new, blank record is displayed and
the browser is reactivated. The MARC record is saved to the active
MARC file (the default file is Marc_001).

For more information on the MARC file, see "About MARC files".

Check
Spelling
button
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Copying MARC records to the clipboard

A new feature of MARConnect lets you copy an entire MARC record to your computer’s
clipboard. Then you can paste the record into the Edit MARC part of Spectrum
CIRC/CAT. Note: Holdings information in tags 852 and 961 are not copied into
Spectrum CIRC/CAT.

This feature lets you quickly copy and paste individual records rather than saving all of
the MARC records into a file and then importing the file into Spectrum CIRC/CAT.

How to copy a MARC record to the clipboard
Example scenario: You have finished cataloging a web site titled Abraham Lincoln. Now
you want to copy the record directly into Spectrum CIRC/CAT using the clipboard.

To copy a MARC record to the clipboard
Important! Do not save the record. Saving the record closes it and
opens a new, blank record. After you save a MARC record in
MARConnect, you cannot edit it again in MARConnect.

After you have entered all of the catalog information, click the
Copy Record to Clipboard button. The entire MARC record is
copied to the clipboard.

You can now paste the MARC record into the Edit MARC part of the Spectrum
CIRC/CAT program.

Pasting MARC records into Spectrum CIRC/CAT
After you copy a MARC record into the clipboard in the MARConnect program, you can
paste the record directly into Spectrum CIRC/CAT. The Edit MARC part of the program
has a new paste feature that places the data from the MARC record into the appropriate
MARC tags, subfields, and indicators. See the Materials chapter in the user and reference
manuals for more information on this feature.

Note: Holdings information in tags 852 and 961 is not copied into Spectrum CIRC/CAT.

Copy Record
to Clipboard
button



MARConnect: Copying MARC records to the clipboard 563
SCC5um1200kn

How to paste a MARC record into Spectrum CIRC/CAT
Example scenario: You have finished cataloging a web site titled Abraham Lincoln and
copied the entire MARC record to the clipboard. Now you want to paste the MARC
record into the Spectrum CIRC/CAT program.

To paste a MARC record into Spectrum CIRC/CAT
1 Start the Spectrum CIRC/CAT program.

2 Open the Material Edit part of the program by clicking the
Materials button in the Navigator toolbar and choosing Edit.
The Easy Entry window opens.

3 Click the Show Edit MARC button. The Edit MARC window
opens.

4 Click the New Record button. A blank MARC record opens.

5 From the Edit menu, choose Select All.

6 From the Edit menu, choose Paste.

7 Click the Save Record button.

You can switch between the MARConnect and Spectrum CIRC/CAT programs by
pressing and holding down the Alt key on your keyboard and pressing the Tab key
simultaneously until the appropriate program icon is selected.

See the Materials chapter in the user and reference manuals for more information on the
Edit MARC part of the program and the paste feature.

Now that the MARC record is in your materials database, your patrons can access it
while searching the catalog. These sites will appear as additional patron resources in
future catalog searches and can be accessed with Spectrum WebConnect, a program that
links patrons to electronic resources cataloged in the MARC 856_u tag. Note: Before you
can search for web sites in Spectrum CIRC/CAT, you must enable Spectrum
WebConnect in Catalog Setup. In the Catalog Setup window, click the Details tab and
select the WebConnect option.
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Importing MARConnect records

After you catalog and save your web sites, you need to import the MARConnect records
into your library’s catalog database. The records MARConnect creates adhere to the
MARC standard, so they can be imported into any industry-standard library automation
system. The method that you use to import MARConnect records depends on your library
automation system. If you’re using Spectrum CIRC/CAT, you can import your
MARConnect records using Material Import. After the records are imported into
Spectrum CIRC/CAT, your patrons can view the web sites in future searches by
accessing them using Spectrum WebConnect, a program that links patrons to electronic
resources cataloged in the MARC 856_u tag.

MARConnect stores your saved cataloged records in a MARC file. The MARC file, by
default, is stored in the same folder as your MARConnect program. You must select this
file to import your cataloged MARConnect records into your database. For further
instructions on importing materials, see the documentation or online Help that came with
your library’s automation system.

The first time you catalog a web site, MARConnect generates and stores your records in
the MARC file named Marc_001 by default. Each time you quit and restart the program,
new records are always appended to the Marc_001 file. Because the program appends
new records to the same file, the program will import all records saved to the Marc_001
file, thus re-importing old records from past imports. If you want to re-import existing
records, don’t change or move your Marc_001 file. If you want to import new records
without re-importing old records, you need to move and change the name of the
Marc_001 file after each import. By doing this, you make it possible for MARConnect to
create a new Marc_001 file when you start the program, and you’re able to save your
imported data to one location.

You need to complete two processes in order to import new records without re-importing
old records:

1 Create a backup MARC file folder

2 Import and move the existing MARC file
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Creating a backup MARC file folder
Before you import the Marc_001 file, you should create a new folder to store backups of
your imported data.

The MARConnect program always appends new records to the Marc_001 file every time
you quit and restart the program. If you don’t move the Marc_001 file after you import it
into your library, Spectrum CIRC/CAT imports all records saved to the Marc_001 file,
thus re-importing old records from your last import to the database.

How to create a backup MARC file folder
Before you import the Marc_001 file into Spectrum CIRC/CAT, you should create a new
folder to store backups of your imported data. Give the folder a unique name. For this
example, let’s call the backup folder MARConnect.

To create a backup folder:
1 In your Spectrum program folder, choose File > New > Folder.

A new folder is created.

2 Name the folder MARConnect.

This folder will store all of your MARC files that contain imported
MARConnect data.

Creating a MARC file in MARConnect
The first time you catalog a web site, MARConnect generates and stores your records in a
Marc_001 file by default. The program shouldn’t change this file unless you tell it to. If
you don’t change or move the Marc_001 file, the program always appends new records to
the Marc_001 file every time you quit and restart the program. Because the program
appends records to the same file, Spectrum CIRC/CAT imports ALL records saved to the
Marc_001 file, thus re-importing old records from your last import to the database.

To prevent this, you need to move the old Marc_001 file to a different location. By doing
this, you make it possible for MARConnect to create a new Marc_001 file each time you
start the program, and you’re able to save your imported data to one location.
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Importing a MARC file into Spectrum CIRC/CAT
The following process outlines how you should import the MARC file. Before you
import into Spectrum CIRC/CAT, you should create a new folder to store backups of
your imported data. For example, you could create a new folder in your MARConnect
folder and name it MARConnect. After you import the MARC file, move it to the
MARConnect backup folder.

If you use a library automation system other than Spectrum CIRC/CAT, the method that
you use to import MARC records may vary. For instructions, refer to the documentation
that came with your library automation system.

How to import a MARC file into Spectrum CIRC/CAT
Example scenario: You’ve cataloged a number of web sites using MARConnect and
saved them to the default Marc_001 file. Now you’re ready to import them into Spectrum
CIRC/CAT.

To import new records without re-importing old records
1 After you’re finished cataloging web sites, exit or close

MARConnect.

2 Start the Spectrum CIRC/CAT program.

2 Import the MARC file (the default is Marc_001). See the
Materials chapter in the user and reference manuals for more
information on importing files into Spectrum CIRC/CAT.

3 When you’re finished importing, locate the MARC file.

4 Move (not copy) the MARC file to the folder you created to
store your imported data, MARConnect.

5 Rename the MARC file. You should make the name unique in
order to distinguish it from other MARC files that will be stored
in this folder. Sagebrush recommends using the date, such as
MARC_9.8.00. This can also help determine when each file was
imported.

If you follow this process each time you import MARConnect records, the backup folder
you create contains each past file of imported data, and the next time you start
MARConnect an empty MARC file is created for storing new records.
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After pasting or importing a MARC file
Once the records are imported, your patrons can view the cataloged web sites in further
searches by accessing them through any program that can provide a link to electronic
resources, such as Spectrum WebConnect, a program that links patrons to electronic
resources cataloged in the MARC 856_u tag.

Note: Before you can search for web sites in Spectrum CIRC/CAT, you must enable
Spectrum WebConnect in Catalog Setup. In the Catalog Setup window, click the Details
tab and select the WebConnect option. For more information, see "Setting details window
options" in the Spectrum CIRC/CAT User Manual or Help system.
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